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Abstract: This workshop covers ways to control messages and items in 
your inbox, including rules, the Out of Office Assistant, junk 
mail filters, folders, and message flagging.   
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Introduction 
Learn to use Rules to manage your email messages to automatically perform actions on 
certain messages.  A rule is a set of conditions, actions, and exceptions that controls how 
Outlook automatically processes and organizes your email messages.   

Objectives 
In this workshop, participants will learn some of the advanced features of Outlook.  Upon 
completion of this workshop the participants should be able to: 

• Use the Rules Wizard and the Organize features to create new rules. 

• Modify, rename, copy and re-order rules. 

• Take advantage of the Out of Office Assistant. 

• Flag messages for follow-up. 

• Create folders to move messages into. 

Although this handout is prepared with Outlook 2002, those using the Outlook 2000 
client should be able to do almost all of the features listed.  If you are interested in 
downloading the Outlook 2000 (for Windows) client, visit 
www.ku.edu/exchange/outlook. 

Prerequisites 
You must have a KU Exchange account.  It is assumed that the participants in this 
workshop have either taken the Outlook: Email Basics workshop or have equivalent 
skills. 

Related Training Available from ACS 
All ACS workshops are free to KU students, staff, faculty, and approved affiliates.  To 
learn more about or register for workshops, receive automatic announcements of 
upcoming workshops, and track workshops you’ve registered for and have attended, visit 
the ACS Web site at www.ku.edu/acs/train. You can also check our online schedule at 
www.ku.edu/acs/schedule for a list of class offerings and their availability. For further 
workshop related questions, please email training@ku.edu. 
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Definitions 
Term Definition 

Information 
viewer 

The section of an Outlook window displaying a specific type 
of item.  Each folder has an Information viewer that displays 
information regarding that folder. 

Item 
Any piece of information created in Outlook, such as an email 
message, a contact, or an appointment. 

Rules Rules can be created to automatically manage incoming 
messages by telling Microsoft Outlook what action to take 
with them. For example, you can create rules to automatically 
move or copy messages to other folders, to delete messages, 
to send custom replies, and so on. 

Out of Office 
Assistant 

If you're not going to check email while you're out of the 
office, use the Out of Office Assistant to manage your Inbox. 
You can automatically respond to incoming mail. 

Folders Outlook saves items of information you create and receive in 
folders. 

Flagged 
Messages 

Use flags to remind yourself to follow up on an issue or to 
indicate a request for someone else. You can also use flags 
to set a reminder for the message. 

Rules Management 
A rule is a set of conditions, actions, and exceptions that controls how Outlook processes 
and organizes your email messages.  The conditions determine which types of messages a 
rule applies to; the actions are what the rule does; the exceptions determine when a rule 
does not apply to certain messages.  Some rules work on messages you receive; other 
rules work on messages you send.   

Rules can be created to run on the Exchange server or on your own computer.  Whether a 
rule is server-based or client-based depends on the exact conditions and actions for that 
rule.  Outlook evaluates each rule you create to see if it can run on Exchange without 
access to your computer.  If that's not possible, Outlook gives you a message stating 
"This rule is a client-only rule, and will process only if Outlook is running."  Outlook 
saves the rule and the wizard window lists the rule with the words "client only" after the 
rule's name.  If the rule can be run on the server, then Outlook automatically saves the 
rule on the server instead of your computer's hard disk.  When a rule is on the server, 
Outlook does not have to be running for the rule to take effect. 

Outlook imposes a maximum size of 32 kB for the rules you save.  The size of each rule 
varies according to its complexity.  You can typically save between 40 and 50 rules.  If 
you attempt to save a rule when no more space is available, a message appears stating 
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"Changes to the rule could not be saved.  There is not enough memory or the rules are too 
complex.  Try deleting some rules."  Also, if a mailbox is over its size limit, it cannot 
execute any rules that will send replies or forward items. 

There are two ways to create rules: 

• Use the Organize pane to create basic rules. 

• Use Outlook's Rules Wizard to create more detailed rules. 

Using Organize to create a Rule 
Organize can be used to move existing messages from the Inbox folder to another folder.  
It can also be used to create rules that move new incoming or outgoing messages to a 
different folder. 

1. Open the Inbox Information viewer. 

2. Click Organize .  The Organize pane appears with the Using Folders section 
displayed. 

3. If you want to move existing messages into a folder, change the information on the 
"Move message selected below to" line. 

• Select the existing messages you want to move.  Hold down the [Ctrl] key to 
select more than one message. 

• Click the drop-down list to choose the folder that you want the selected messages 
to move to.  If the folder name does not appear in the list, select Other folder…..  
The Select Folder dialog box appears allowing you to select the folder of your 
choice or create a new one. 

• Click Move. 

• The word Done appears to indicate that the process is complete. 

4. If you want to create a rule that moves incoming mail to a different folder, change the 
information on the "Create a rule to move new messages" line. 

• When creating a rule that applies to messages from someone, select from in the 
first drop-down list.  When creating a rule that affects messages sent to someone, 
select sent to. 

• The name of the sender, whose messages you want the rule to apply to, goes in 
the next field.  You can type in the name, or select an existing message from that 
person in the Inbox. 

• On the last line, click the drop-down list to view your Outlook folder list.  Select 
the folder where you want to move new incoming mail into.  If the folder name 
does not appear in the list, select Other folder....  The Select Folder dialog box 
appears allowing you to select the folder of your choice or create a new one. 

• Click Create.  A following message appears. 
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“This rule will be applied…“ message 

If you want to "...run this rule on the current contents of the folder", click Yes.  
Click No if you want the rule to apply only to new messages. 

• If the new rule can be run on either the server or client (your computer), a dialog 
box appears.  Click Server so that messages are processed by the rule when you 
are not running Outlook and when your computer is turned off.  

• The word Done appears to indicate that the rule was applied to the existing 
message or will be applied to all incoming messages. 

5. Click X to close the Organize pane. 

Using Rules Wizard to create a Rule 
The Rules Wizard helps you manage your email messages by using rules to automatically 
perform actions on messages.  After a rule is created, Outlook applies the rule when 
messages arrive or when you send a message.  You can add exceptions to your rules for 
special circumstances, such as when a message is flagged for follow-up action or is 
marked with high importance.  A rule is not applied to a message if any one of the 
exceptions you specify is met.   

The Rules Wizard leads you through three basic steps to create a rule to manage your 
messages:  selecting a condition, applying an action to the items returned by the 
condition, and entering exceptions to the condition. 

1. With the Inbox open, click the Tools menu and select Rules Wizard....  The Rules 
Wizard dialog box appears. 

 
Rules Wizard dialog box 
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Alternatively: If you are working with an open message and want to build a rule 
from information in that message, click the Actions menu and select 
Create Rule….  Then skip to step 6 below.  The Rules Wizard is 
already filled in with the basic information from the email message.  
Follow the steps from #6 to complete the rule. 

2. In the Apply changes to this folder list, click the Inbox you want this rule to affect. 

3. Click New... to start creating a new rule.  The Rules Wizard displays a list of the 
different types of rules you can create along with a description of the rule in the Rules 
description box. 

 
Rules Wizard -- Different rule options and their descriptions 

4. Above the upper box, select one of the following: 

• Click Start creating a rule from a template to use a template with pre-specified 
actions and conditions. 

• Click Start from a blank rule to use your own conditions and actions. 

Then, from the list choose which type of rule you want to create.  A description of the 
rule appears in the lower box. 

5. Click Next. 

6. This dialog box displays a list of conditions that must be satisfied for the rule to be 
applied.  One condition may already be checked based on the type of rule you chose 
to create.  Check as many additional conditions that may apply.  A description of 
each rule/condition appears in the lower box.   

Note: Some rules require additional information.  In some cases there are 
underlined values in the description box.  Click an underlined value to 
edit it.  Additional dialog boxes appear walking you through the steps 
of choices.  Click OK to set the values of these boxes.  Notice the 
underlined values change in the description box. 
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Tip: If you have an underlined value that requires an email address that is 
not in the Global Address List or your Contacts, you can click the 
cursor in the "Specify the address to the sender:" box of the Rule 
Address dialog box and type it in manually. 

7. Click Next. 

8. This dialog box displays a list of actions for the rule.  One action may already be 
checked based on the type of rule you chose to create.  Check as many additional 
actions that may apply.  A description of each rule/action appears in the lower box.  
Some actions may require additional information.  Click an underlined value to edit 
it. 

9. Click Next.  A dialog box appears allowing you to make exceptions to your rule. 

 
Rules Wizard – Exception options and their descriptions 

You don't have to select any exceptions, but you can check as many exceptions as 
necessary.  When an exception is selected, then the condition is added to the rule 
description box.  Again, some exceptions may require additional information.  Click 
an underlined value to edit it. 

10. Click Next.  The final Rules Wizard dialog box appears. 

11. A suggested name is in the Please specify a name for this rule: field.  You can easily 
change the name of the rule if you want.   

12. Select one of the following: 
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• Check the Run this rule now on messages already in "Inbox" if you want the 
rule to take affect immediately and be applied to any existing messages meeting 
the specified criteria. 

• Turn on this rule is on by default.  Click to uncheck it only if you do not want 
the new rule to begin treating incoming messages accordingly. 

• Click the Back button to make any changes to the rule before you save it. 

13. Click Finish.   

14. The first Rules Wizard dialog box reappears listing the name of the rule and its final 
description.  The checkmark means that the rule is on and will be applied to every 
message that the criteria you specified is met.  If you uncheck a rule, the rule still 
exists but Outlook doesn't apply the rule to any new incoming or outgoing messages.  
If the rule has "client-only" behind the name, it is stored on your computer.  If the 
rule name doesn't have anything behind it, then the rule is stored on the server.  Click 
OK to close the Rules Wizard dialog box. 

Note: The Rules Wizard treats meeting requests, task requests, and documents as 
messages.  You can create a rule that moves items with the word "meeting" 
in the Subject: field, and any task or meeting request that fulfills that 
criterion is moved. However, there are a few things to keep in mind when 
creating rules that affect these types of items:  

• If an item is moved from the Inbox, the automatic processing will not 
work.  In particular, that means that voting buttons, meeting, and task 
responses will not be processed. 

• If a meeting or task response is moved to the Deleted Items folder by 
using a rule, the tracking in the original item is not updated. 

• If a meeting request is moved to the Deleted Items folder, the meeting is 
not added to the Calendar. 

• You cannot flag a meeting or task request by using a rule. 

• Rules made to be applied when you send a message are not applied to 
task requests and meeting requests. 

Modifying a Rule 
Although you can create Rules in two different ways, you can only use the Rules Wizard 
to make changes to an existing rule. 

Editing a Rule 
1. With the Inbox open, click the Tools menu and select Rules Wizard....  The Rules 

Wizard dialog box appears listing your rules. 

2. Select the rule you want to modify. 

3. Click Modify.... 
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4. Click Next to proceed through the dialog boxes as needed.  Make whatever changes 
are necessary by selecting another type of rule or by clicking the underlined values in 
the description box. 

5. Click Finish to signify that you have made all your changes. 

6. Click OK to close the Rules Wizard dialog box. 

Changing the order of a Rule 
Outlook applies rules to messages in the order those rules are listed in the Rules Wizard.  
In the case of incoming messages, Outlook applies rules to messages as they arrive in 
your Inbox folder.  If a rule moves a message from the Inbox folder to another folder, 
additional rules are no longer applied to that message.  In the case of an Outgoing 
message, Outlook applies rules to messages as they arrive in the Sent Items folder.  
Therefore, it is important that rules are processed in the right order.  After multiple rules 
have been created, the rules can be moved up or down in the list to change the order in 
which they are applied. 

1. With the Inbox open, click the Tools menu and select Rules Wizard....  The Rules 
Wizard dialog box appears listing your rules. 

2. Select a rule you want to move up or down. 

3. Click Move Up or Move Down to move the rule appropriately, one line at a time. 

Note: Rules that are marked "client only" are applied after all other rules.  Also, 
they only run when the Outlook client open. 

4. When you are done rearranging the rules, click OK. 

Turning a Rule on or off 
1. From the Inbox Information viewer, click the Tools menu and select Rules 

Wizard....  The Rules Wizard dialog box appears listing your rules. 

2. A rule that is active has a checkmark beside it.  A disabled rule has a blank box by it.  
A disabled rule still exists, but is not run on mail messages. 

• To turn a rule off, click the checkmark beside the rule. 

• To turn a rule on, click the blank check box beside the rule. 

Tip: If you want to run a rule periodically after creating it, turn it off.  Then 
when you want to run it, click Run Now…. 

3. Click OK to close the Rules Wizard dialog box. 

Deleting a Rule 
1. With the Inbox open, click the Tools menu and select Rules Wizard....  The Rules 

Wizard dialog box appears listing your rules. 

2. Select the rule you want to delete.   

3. Click Delete and click OK to close the Rules Wizard dialog box. 
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Printing Rules 
You cannot print out a copy of your rules.  If you want a record of your rules, you need to 
jot down the conditions, actions, and exceptions manually. 

Using the Out of Office Assistant 
The Out of Office Assistant is a feature that allows you to notify other KU Exchange 
users via email when you are away from the office.  You can also use the Out of Office 
Assistant to apply rules to incoming items while you are not checking your email.  When 
an Outlook user sends you an item, the Out of Office Assistant feature automatically 
responds to the item with a notice, indicating that you are away from the office.  The 
notice can display any text that you choose to send to other Outlook users, including the 
dates and times you are out of the office and any additional information such as whom to 
report to with questions.  The notice is sent only once to each person that sends you an 
item. They can continue to send you messages, but they will not continue to be notified.  
Your messages are stored on the Exchange server until you turn off the Out of Office 
Assistant. 

Note: This feature will not send notifications to email addresses outside of the KU 
Exchange system.  If you need people to outside of the KU system to be 
notified that you are out of the office, then use the Automatic Reply to Rules 
below. 

1. With the Inbox open, click the Tools menu and select Out of Office Assistant....  
The Out of Office Assistant dialog box appears. 

2. Select I am currently Out of the Office. 

3. In the box under AutoReply only once to each sender with the following text:, type 
the message you want to send to people. 

4. Click OK. 

Remember: It is important to remember to turn the Out of Office Assistant "off" 
when you are back in the office.  Click the Tools menu and select Out 
of Office Assistant..., then select I am currently in the Office. 

Creating a Rule in the Out of Office Assistant 
You can use the Out of Office Assistant command to define rules that should be applied 
only when you are away from the office.  Any rules that you have defined by using Inbox 
Assistant continue to be applied to incoming mail.  For example, you can define a rule 
that automatically forwards high-importance messages to a co-worker. 

1. With the Out of Office Assistant dialog box open, click Add Rule....  The Edit Rule 
dialog box appears.   
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Edit Rule dialog box 

2. The top section of the dialog box contains boxes in which you can specify certain 
conditions of incoming messages.  The rule is applied only if it satisfies all the 
criteria you define in these boxes. 

3. The bottom section of the dialog box is where you define what action the rule 
performs. 

4. You can make more precise definitions of the message to be acted on by clicking 
Advanced.... to display the Advanced dialog box. 

5. Click OK.  The rule appears in the Out of Office Assistant dialog box. 

6. Click OK to close the Out of Office Assistant dialog box. 

Automatic Reply to Rules 
Microsoft Exchange server and the Outlook client allow you to create rules to reply 
automatically to incoming messages.  The Have server reply action allows you to build 
server-based reply rules.  When you create such a rule, Outlook prompts you to create the 
reply message as part of the process.  The reply is sent each time a message is received.  
You can set up an exception to the rule if you don’t want the message to go to any lists.  
This rule must be the first rule listed to work properly.  If it is not, then another rule may 
process messages before this rule.  Also, the biggest disadvantage is that there is no 
reminder that this rule is on.  You have to remember to turn the rule off when you return. 

1. With the Inbox open, click the Tools menu and select Rules Wizard….  The Rules 
Wizard dialog box appears. 

2. Click New… to start creating a new rule.   

3. Click Start from a blank rule. 
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4. Select Check messages when they arrive. 

5. Click Next. 

6. Do not select a condition.  Simply click Next.   

7. A message appears informing you that the “rule will by applied to every message you 
receive”.  Click Yes. 

8. Check the action have server reply using a specific message.  

9. A description of the rule/action appears in the lower box requiring additional 
information.  Click the underlined value to edit it. 

10. An Untitled-message form appears.  Type in a subject and body for the message. 

Caution: Do not put anything in the To… or Cc… fields, or the message will 
only go to those people. 

11. When you are done creating the reply message, click Save and Close on the message 
form.  The underlined value is replaced with the subject you gave. 

12. Click Next.  A dialog box appears allowing you to make exceptions to your rule.  
You don’t have to select any exceptions, but you can check any exceptions necessary.  
This would be a good time to note if you do not want any list you may be on to 
receive the reply message.  Again, some exceptions may require additional 
information.  Click an underlined value to edit it. 

13. Click Next.  The final Rules Wizard dialog box appears. 

14. A suggested name is in the Please specify a name for this rule: field.  You can easily 
change the name if you want.  Be sure the Turn on this rule is checked. 

15. Click Finish.   

16. The first Rules Wizard dialog box reappears listing the name of the rule and its final 
description.  The checkmark means that the rule is applied to every message you 
receive or send.  Be sure to move the rule to the top of the list so that it is applied first 
as messages are received.  If all the criteria you specified is met then the rule is 
applied.  You can uncheck the rule, the rule still exists but Outlook doesn’t apply the 
rule to any new incoming or outgoing messages.  Click OK to close the Rules 
Wizard dialog box. 

Important Reminder: Remember to turn the rule off when you return.  You 
may want to set up a Task to remind you to do this. 

Setting up a Spam Rule 
KU has a spam filter at the server level to help manage the flow of spam messages. This 
filter affects all email addressed to a KU alias, i.e. user@ku.edu (or 
user@ukans.edu).  It will not affect email addressed directly to a particular server, e.g., 
user@mail.ku.edu or user@lark.cc.ku.edu.  The filter does not eliminate email 
messages; it "tags" potential spam. When the filter identifies a message as potential 
spam, the subject line is altered to read [Spam:0005 SpamScore] Original subject.  The 
value of the number indicates the likelihood that the message is spam.  The greater the 
number, the higher the probability that it is. 
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1. With the Inbox open, click the Tools menu and select Rules Wizard.... The Rules 
Wizard dialog box appears.  

2. Click New... to start creating a new rule. The Rules Wizard displays a list of the 
different types of rules you can create along with a description of the rule in the Rules 
description box.  

3. Above the upper box, select Start from a blank rule to specify your own conditions 
and actions. Click Next.  

4. This dialog box displays a list of conditions that must be satisfied for the rule to be 
applied. Check with specific words in the subject. A description of the 
rule/condition appears in the lower box.  

5. Click the underlined value to edit it. The Search Text dialog box appears.  

6. Type [SPAM: in the Select words or phrases to search for in the subject: field.  

7. Click Add. The text [SPAM: will be added to the Search list:.  

8. Click OK. The underlined value new shows the text you added.  

9. Click Next.  

10. This dialog box displays a list of actions for the rule. Check move it to the specified 
folder. A description of the rule/action appears in the lower box.  

11. Click the underlined value to edit it. The Rules Wizard dialog box appears.  

12. Click New.... The Create New Folder dialog box appears.  

13. Type a name for your folder in the Name: field. Click OK.  

14. Click OK to close the Rules Wizard dialog box. 

Note: The suggestion is to move these messages into a specific folder for 
the time being. This allows you to monitor what the spam tag is 
actually tagging. After a while, you may feel comfortable enough to 
change this setting to "Permanently delete items". 

15. Click Next. A dialog box appears allowing you to make exceptions to your rule. You 
don't have to select any exceptions, but you can check as many exceptions as 
necessary. When an exception is selected, then the condition is added to the rule 
description box. Again, some exceptions may require additional information. Click 
an underlined value to edit it.  

16. Click Next. The final Rules Wizard dialog box appears.  

17. A suggested name is in the Please specify a name for this rule: field. You can easily 
change the name of the rule if you want.  

18. Select one of the following:  

• Check the Run this rule now on messages already in "Inbox" if you want the 
rule to take affect immediately and be applied to any existing messages meeting 
the specified criteria.  

• Turn on this rule is on by default. Click to uncheck it only if you do not want 
the new rule to begin treating incoming messages accordingly.  
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• Click the Back button to make any changes to the rule before you save it.  

19. Click Finish.  

20. The first Rules Wizard dialog box reappears listing the name of the rule and its final 
description. The checkmark means that the rule is on and will be applied to every 
message for which the criterion you specified is met. The rule is stored on the server. 
Click OK to close the Rules Wizard dialog box. 

Dealing with additional Junk mail 
You will continue to receive spam messages that are not flagged by the SpamScore 
system.  Outlook has a built-in filter to deal with messages containing certain words and 
phrases in the subject or body.  A list of terms that Outlook uses to filter suspected junk 
e-mail messages can be found in a file named Filters.txt on your hard drive.  If you do not 
want to receive these Junk Mail messages, Outlook can automatically move them from 
your Inbox to your Deleted Items folder or to any other folder you specify.  Outlook 
creates a folder called Junk Mail, where you can move junk e-mail and then review it 
before deleting.  Or, you can have junk e-mail delivered to your Inbox, but color-coded 
so you can easily identify it. 

Turning on the Junk mail filter 
These instructions give you the option to color-code or move the filtered email to a specified 
folder or your Deleted Items.  We recommend that you move items to a Junk Email folder 
until you are sure that this filter is working correctly for you.  Once you are comfortable that 
this filter is not affecting any important email, you can change it to send filtered items 
directly to the Deleted Items folder. 

Note: This filter is actually a rule that is client-only.  That means that it will only 
work on the machine where you set it up.  If you use Outlook at the office 
and at home you will need to go through this process on both machines.  If 
you read your email using Outlook Web Access the filter will not work. 

1. From the Main window, click Organize .  The Organize pane appears. 

2. Click Junk E-Mail.  There are two separate fields to deal with Junk and Adult 
Content messages separately. 

3. Click in the drop-down lists to select either  

• a color to add to the message. 

• move messages to a different folder. 

4. Click Turn on next the field(s) you changed. 

5. Click X to close the Organize pane. 

Adding a sender to the Junk mail list 
Names and email addresses can easily be added to the Junk and Adult Content mail lists. 

1. With your Inbox open, locate and select the message that you want to add to your 
Junk or Adult Content mail list.   
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2. Click the Actions menu, point at Junk E-mail, and then select Add to Junk Senders 
list. 

Alternatively: Right-click the message.  From the submenu, point on to Junk E-
mail and select either Add to Junk Senders list or Add to Adult 
Content Senders list. 

3. A confirmation message appears saying that the selected name(s) has been added to 
the list you chose. 

Editing the Junk mail list 
You can also manually add names to the Junk and Adult Content mail lists as well as 
remove names you previously added 

1. From the Main window, click Organize.  The Organize pane appears. 

2. Click Junk E-Mail.   

3. Click click here. 

4. Click Edit Junk Senders or Edit Adult Content Senders. 

5. Do one of the following: 

• Click Add… and type the full email address of a sender in the text box area and. 

• Select the name of a sender and click Edit… to make changes to a name. 

• Select the name of a sender and click Delete to delete a name from the list. 

6. When you are done making changes, click OK. 

7. Click X to close the Organize pane. 

Flagging a message 
Some email messages in your Inbox might require follow-up action, such as placing a 
phone call, replying to the email message, or checking further on information presented 
in the email message.  To note and track follow-up activities, you can use the flag feature.   

You can also flag an outgoing message to draw the recipient’s attention to it.  Flags you 
attach to messages are delivered with the message to the recipient.  Only other Outlook 
users are able to see flags. 

Flagged messages should be stored in the Inbox.  Outlook displays reminders at the 
appropriate time for flagged messages, but only if those messages remain in the Inbox.  
Outlook doesn’t create reminders for flagged messages if the messages are moved to 
folders other than the Inbox. 

1. Create a message to send or open an existing email message. 

2. Click the Actions menu and select Flag for Follow Up….  The Flag for Follow Up 
dialog box appears. 

Alternatively: 
You can click Flag for Follow Up . 
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3. Select the type of flag you want to use.  To display a list of flag types, click the down 

arrow next to the Flag to: field. 

Tip: You are not limited to the flag names.  You can select any flag so that 
its name appears in the Flag to: field, then replace that name with 
whatever words are appropriate by typing in the new word(s). 

4. If you don’t want to specify a date in the flag, ignore the Due by: field.  If you want 
to include a due date with the flag, either type in a date or click the down arrow next 
to the field and select a date from the calendar. 

You are not limited to the flag names.  You can select any flag so that its name 
appears in the Flag to: field, then replace that name with whatever words are 
appropriate by typing in the new word(s). 

Tip: Instead of selecting a date from the calendar, you can type descriptive 
words such as “tomorrow,” “next week,” and so on, as well as 
abbreviations such as “1d” for tomorrow and “1w” for next week. 

If you choose a date from the calendar, Outlook automatically shows the time that 
corresponds to the end of your workday.  You can replace the time Outlook displays 
with whatever time you want by selecting it and typing in a different time. 

5. Click OK.  The flag you added to your message appears in the InfoBar above the 
header. 

 
The InfoBar shows the flag information. 

6. Finish creating the message and click Send or close the edited message. 

Marking a flagged message as completed 
After action on the flagged message has been taken, the flag needs to be marked as 
completed.  If a flag is passed due, the flagged message line becomes red. 



ACS Computer Training 
Outlook Controlling Your Inbox 

Academic Computing Services - 18 - © 2004 The University of Kansas 
A Division of Information Services 

1. Open your Inbox, if it isn’t already. 

2. Open the flagged message. 

3. On the Message window’s toolbar, click Flag For Follow Up .  The Flag For 
Follow Up dialog box appears. 

4. Click the Completed check box. 

5. Click OK.  On the Message window, the completion date is added to the InfoBar. 

6. Close the message.  The flag next to the message has been changed from red to gray. 

Alternatively: To clear the flag, right-click the message in the Inbox Information 
viewer.  From the submenu, select Clear Flag. 

Folders in Outlook 
Outlook saves items in a set of ten folders, one folder for each type of Outlook item.  
These folders are: 

• Calendar – for Outlook items that describe dated activities 

• Contacts – for Outlook items that contain information about people or organizations 

• Deleted Items -- for Outlook items that you have deleted from other Outlook folders 

• Drafts – for messages you are working on but are not ready to send 

• Inbox – for messages you have received 

• Journal – activities that are recorded 

• Notes -- for Outlook items you create to jot down questions, ideas, reminders, and 
anything you would write on note paper  

• Outbox –where Outlook temporarily saves messages you have created until a 
connection to a mail server is available or until the scheduled delivery time you 
specified occurs 

• Sent Items – for copies of messages you have sent 

• Tasks – for tasks you have created for yourself, asked other people to accept, or 
accepted from other people 

You can create additional folders, and you can create subfolders below the ten default 
folders as well as below any other folders you create.  Any folders created under the 
default folders reside on the Exchange Server. 

Each Outlook folder can contain one type of Outlook item, other Outlook folders, and 
files.  If you attempt to save an Outlook item of one type in an Outlook folder that is 
intended for Outlook items of a different type (e.g. a mail message in the calendar folder), 
Outlook automatically converts the item being saved into an Outlook item of the type the 
folder holds.  Although an Outlook folder can contain Outlook items of only one type, it 
can contain Outlook subfolders that contain Outlook items of a different type. 
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Folders are arranged in a tree structure with the root name at the top.  This root name 
represents the mailbox on the Exchange server.  The folders in which Outlook saves 
items are listed under the root name, “Outlook Today – [Mailbox—your name]”. 

 
The Folder list in Outlook 

Creating a new folder or subfolder 
The new folder can be a top-level folder (at the same level as the default Outlook 
folders), a subfolder under a top-level folder (either one of the default Outlook folders or 
a top-level folder you have created), or a subfolder within an existing subfolder. 

1. Be sure the Folder List is displayed.  If not, click the View menu and select Folder 
List. 

2. Right-click the folder in which you want the new folder created under and select New 
Folder… from the submenu.   

Alternatively: Click the File menu, point onto Folder, and select New Folder… 
or click the File menu, point onto New, and select Folder….   

The Create New Folder dialog box appears. 

 
Create New Folder Dialog Box 

3. In the Name: field, type a name for the new folder.  It should be a different name 
from any folder that already exists at the same level as the new folder. 
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4. Click the drop-down list under the Folder contains: field and select the type of item 
you will place in the new folder or subfolder.  Each folder or subfolder can contain 
items of only one type. 

5. In the Select where to place the folder: field, select the folder below which you want 
to place the new folder or subfolder.  Select the root name if you are creating a folder 
that is to be at the same level in the folder structure as the default folders in Outlook.  
If you are creating a subfolder, select the existing folder below which you want the 
new subfolder to be placed. 

6. Click OK to create the folder.   

7. Outlook asks whether you want to place a shortcut to the new folder or subfolder on 
the Outlook Bar.  Click Yes or No according to your preference.  

Tip: If you create folders you are going to access frequently, it is 
convenient to add icons representing those folders to the Outlook Bar.  
You can add icons to the standard groups of the Outlook Bar, or you 
can create one or more custom groups in the Outlook Bar for these 
icons.   You can select a folder you want to add a shortcut to the 
Outlook Bar and drag it onto the Outlook Bar.  Use the arrows that 
appear to position the shortcut where you want it. (Make a link to the 
Intro handout regarding this) 

The new folder or subfolder appears in the Folder List.  The plus and minus buttons 
appear next to folders that contain subfolders.  Click the plus button (+) next to the 
folder to display subfolders, or the minus button (-) to hide subfolders. 

Opening a folder or subfolder in a new window 
You can open a folder in its own window.  Select the folder.  Right-click the folder and 
select Open in New Window.  By doing this, you can have two or more Outlook folders 
visible at the same time.  This is helpful when you want to refer to information in one 
Outlook folder while you are working with information in another.   

Copying a folder or subfolder 
You can copy any folder or subfolder, including Outlook’s default folders, and its 
contents to another location within your Folder List.   

1. Right-click the folder that you want to copy.   

2. Select Copy ‘folder name…’ from the submenu.  The Copy Folder dialog box 
appears. 

3. Select the name of the folder under which you want the new folder to be.  You may 
need to expand the Folder List. 

Tip: You can copy a folder by dragging it to a new location while pressing 
the [Ctrl] and [Alt] keys on the keyboard at the same time. 

4. Click OK. 



ACS Computer Training 
Outlook Controlling Your Inbox 

Academic Computing Services - 21 - © 2004 The University of Kansas 
A Division of Information Services 

When you copy a folder or subfolder, the copy has the same name as the original.  
Outlook will let you have two or more folders or subfolders with the same name 
providing those folders are not at the same level of the folder structure. 

Moving a folder or subfolder 
You can move only those folders or subfolders you have created (not Outlook’s default 
folders), including their contents, to other locations within your Folder List.   

1. Right-click the folder that you want to move.   

2. Select Move ‘folder name…’ from the submenu.  The Move Folder dialog box 
appears. 

3. Select the name of the folder under which you want the new folder to be. 

Tip: You can move a folder by dragging it to a new location 

4. Click OK. 

Note: You can copy and move Outlook items from one folder to another.  
Each folder can hold only one type of Outlook item.  If you copy or 
move an item from one folder to another folder of the same type, the 
item is unchanged.  When you copy or move an item to a folder of a 
different type, Outlook changes the item to the type of the new folder.  
when you copy an item, Outlook creates a new item in another folder, 
leaving the original item in its folder.  When you move an item, 
Outlook places the item in another folder, deleting it from the original 
folder. 

Deleting a folder or subfolder 
You can delete a folder or subfolder you create, but not one of Outlook’s default folders.  
There are several ways to delete a folder.  When you delete a folder, Outlook moves that 
folder and its contents into the Deleted Items folder.   

Right-click the folder you want to delete and select Delete ‘folder name…’ from the 
submenu.   

Tip: You can delete a folder or subfolder by dragging it to the Deleted 
Items folder. 

The folder immediately disappears from the Folder List.  The deleted folder becomes a 
subfolder of the Deleted Items folder.  You can, if necessary, drag the folder and its 
contents from the Deleted Items folder back into its original (or a different) place in the 
folder structure. 

Renaming a folder or subfolder 
You can rename a folder or subfolder you have created, but not one of Outlook’s default 
folders. 



ACS Computer Training 
Outlook Controlling Your Inbox 

Academic Computing Services - 22 - © 2004 The University of Kansas 
A Division of Information Services 

1. Right-click the folder you want to rename and select Rename ‘folder name…’ from 
the submenu. 

2. The folder name is listed for you to edit.  Type in a new name for the folder. 

3. Press the [Enter] key. 

Understanding Folder Properties 
Each Outlook folder has a set of properties that you can customize.  

1. Right-click a shortcut icon in the Outlook Bar or right-click a folder name in the 
Folder List to display the folder’s submenu and then select Properties.   The 
Properties dialog box for the selected folder appears 

.  

Folder Properties 

General tab – specifies a new name or a description for the folder and displays its 
location. 

Home Page tab – associates a folder with a Web page or other page defined by HTML 
code. 

AutoArchive tab – defines how Outlook archives items within a folder.  By default, 
AutoArchiving is turned on.  Outlook defines a specific aging period for each type of 
item.  When AutoArchiving occurs, items older than the aging period are archived. Also, 
by default, Outlook saves archived items in a folder named Archive.pst.  For more 
information on AutoArchiving see the Introduction to Outlook handout.   

Note: The Contacts folder does not have an AutoArchive tab because Outlook 
doesn’t automatically archive Contact items.  The Contacts folder 
properties does have two additional tabs:  Outlook Address Book and 
Activities.  The Outlook Address Book tab allows Outlook to use the 
contents of a Contacts folder as an email and fax address book.  The 
Activities tab allows you to define the activities Outlook associates with 
contacts. 
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Administration tab – specified the initial view for the folder, adds the folder address to 
your personal address book, opens the Folder Assistant dialog box, and sets other options. 

Forms tab – copies a form from a different forms library to the Folder Forms Library, 
or sets up a new form in the Folder Forms Library. 

Permissions tab – defines the default permissions for users of the folder and sets 
access permissions for specific users.  If this is a folder that someone else created, such as 
a public folder, there is a Sharing tab instead of the Permissions tab. 

Synchronization tab – specifies whether a folder is available only when online or 
when both online and offline. 

1. The box at the top of the dialog box contains the name of the folder.  You can not 
change the name of Outlook’s default folders, but you can change the name of a 
folder or subfolder you create.  If this is a Personal Folders file you have created, you 
can change the name of the folder by clicking Advanced…. 

• The Advanced dialog box gives you advanced options.  You can: 

• In the Name: field, type a new name for the folder. 

• Click Change Password to change a password or start protecting the file with a 
password, which is not recommended.. 

• Click Compact Now to recover the space on your hard drive previously occupied 
by items you have deleted from the Deleted Items folder. 

• Click Allow upgrade to large tables to check mark it.  Outlook is limited to 
approximately 16,000 folders per file and 16,000 items per folder.  When 
checked, Outlook can accommodate approximately 64,000 folders per file and 
64,000 items per folder.  

• Click OK to exit the Advanced dialog box. 

2. Use the blank box under the Description: field to type information about the folder. 

3. The When posting to this folder, use: field, contains the name of the default form 
used to enter information.  Click the drop-down list to choose a different form. 

4. If you intend to share this folder with other Exchange users, leave the Automatically 
generate Microsoft Exchange views field checked. 

5. Click Folder Size… to view the size of the folder. 

 
Folder Size 
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Note: If you are looking at the Properties of the Outlook Today folder, the 
folder size allows you to see the size of all your Outlook folders on the 
Exchange server. 

6. Click OK to exit the Properties dialog box. 

For More Information 
Here are some additional sources of information about Outlook and Exchange: 

KU’s Exchange & Outlook Support – 864-0200 

Exchange Email Help – exchange@ku.edu 

Email your questions, problems or concerns to the Exchange team. 

Website FAQs – www.ku.edu/exchange/faqs.shtml 

Questions and information related to KU’s Exchange project and using the Outlook client 
can be located at this Web site. 

Other Help Options -  

Like other Microsoft Office applications, Outlook has a Help menu and an Office 
Assistant that can be used to get online help.  Selecting Help from the Help menu allows 
you to use the Office Assistant or the Outlook Help file to find the information you need.  
You can also use the What’s This feature to find out about a part of the Outlook window 
or what a button or box does.  All of the following features can be located under the Help 
menu on the toolbar. 

Using the Office Assistant -- When you first start Outlook, the Office Assistant appears 
on your screen.  You can choose any of the items listed in the Office Assistant balloon.  
You can also type a question and click Search.  The Office Assistant provides a list of 
relevant topics.  If you select a topic, the Office Assistant opens a window that provides 
detailed information about that topic.  The Office Assistant can be hidden or closed. 

Using the on-line help -- The Help window has two panes.  The left pane allows you to 
select topics and the right pane shows information about the select topics.  There are three 
tabs: Contents, Answer Wizard, and Index.  The Contents tab allows you to select general 
areas of information, the Answer Wizard tab allows you to ask a question in your own 
words, and the Index tab provides an alphabetical list of major help topics. 

What’s This? -- When you select this option from the Help menu, a question mark is 
added to the pointer.  Using this question mark pointer, you can point onto any menu item 
and click to get information about that item, or point onto any region of an Information 
viewer or form and click to get information about that region. 

Office on the Web -- Outlook opens Internet Explorer and opens a Web site with 
information about Office 2000 applications. 

Detect and Repair -- Activates a utility that examines your Office installation and 
automatically corrects errors. 
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Getting Additional Help 
ACS provides consulting and Q&A help in a variety of ways: 

785/864-0200 
question@ku.edu 
www.ku.edu/acs/help 

Last Update: 06/24/2004 


